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1 GETTING STARTED 

1.1 UI CONVENTIONS 
The UI Conventions used in this document are meant to convey visually the information from the UI to 

the manual.  The following conventions are used is this manual: 

 Button (both dialog and ribbon): [OK] 

 Dialog label: Parameters 

 Context menu item: “Send to Viewer” 

 Tab label: File 

1.2 INSTALLATION AND LICENSING 
Installation of the IApioneer software is very simple.  Standard installer packages are available for MS 

Windows. 

Minimum System Requirements 

 Windows XP SP2, Vista, or Windows 7* 

 4 GB RAM 

 Core 2 Duo processor 

 7200 RPM hard drives 

 250MB Disk Space 

 OpenGL 2.1 supported graphics card† 

 Two-Button Mouse with a scroll wheel 

 

Recommended System Requirements 

 Windows 7 

 4 GB RAM 

 Core i5 processor 

 7200 RPM hard drives 

 1GB Disk Space 

 Graphics Card: NVIDIA graphics card 

 Two-Button Mouse with a scroll wheel 

                                                           
*
 The software runs as a 32-bit application under 64-bit processor architectures to support legacy deliveries and 3

rd
 

party library integration 
†
 GPU acceleration for some processes not supported on all graphics architectures 
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1.3 HOW TO CONTACT US 
Software support is available from IAVO Research and Scientific to assist with software technical issues.  

Before you contact us, please have the following information ready: 

 Company Name 

 Customer Number 

 Email Address 

 Product name and version 

 Computer O/S version 

 Error message, if any 

 Steps necessary to re-create the issue 

By e-mail: 

support@iavo-rs.com 

By phone: 

Direct: 919-433-2400 

Toll Free: 888-860-4286 

For more information, see http://iapioneer.com/support.html. 

  

mailto:support@iavo-rs.com
http://iapioneer.com/support.html
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1.4 USER INTERFACE (UI) 

1.4.1 ELEMENTS OF THE UI 
Figure 1 shows the components of the user interface. 

 

Figure 1. Components of the user interface, shown with the demo dataset loaded. 

1. The Ribbon – The tabs of the Ribbon organize capabilities by module, allowing the user to 

interact with the data in a logical manner.  The Home tab contains all of the camera and image 

viewing tools, including; zoom, rotation, brightness, contrast, and histogram adjustments.  Each 

of these is applied to the active viewer only.  In addition to the Home tab, each licensed 

processing module may add one or more tabs to the Ribbon. 

2. Left Viewer – One of the two primary viewers used to interact with the data.  Images can be sent 

to the Left Viewer from the Image Gallery.  Data layers (vectors, tie points, and annotations) can 

be displayed from the Layer Manager. 
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3. Right Viewer – One of the two primary viewers used to interact with the data.  Images can be 

sent to the Right Viewer from the Image Gallery.  Data layers (vectors, tie points, and 

annotations) can be displayed from the Layer Manager. 

4. Image Gallery –Thumbnails of the raster data loaded in the current session are displayed here.  

Images can be added to the Left or Right Viewers by right-clicking on the thumbnail in the Image 

Gallery and selecting “Send to Left Viewer” or “Send to Right Viewer”. 

5. Layer Manager – Vector, tie point, and annotation layers loaded in the current session are listed 

here.  Each has a checkbox to indicate whether or not it is displayed in the viewers, and a radio 

button to select the actively editable layer. 

1.4.2 THE BACKSTAGE 
Data loading and system parameters are accessed through the Backstage (Figure 2), which can be 

brought up by clicking on the File tab in the Ribbon.  Here, you can load/remove data, save/open 

sessions, and access the Help and Settings for the application. 

 

Figure 2. The Backstage, shown with the demo dataset loaded. 
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The Session section of the Backstage lists all of the data currently loaded in the session.  It also has the 

ability to create new data layers (vectors, tie points, and annotations).  The data are organized by 

category: Images, DEMs, Vectors, Tie Points, and Annotations.  DEMs are a special form of raster image, 

where the pixel value corresponds to an elevation. 
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2 LOADING AND VIEWING DATA 
You can load a number of different types of data into IApioneer, including: satellite imagery, aerial 

imagery (scanned film and digital images), orthographic images, Digital Elevation Models (DEMs), 2D and 

3D vectors, tie points, and annotations. 

2.1 LOADING DATA INTO THE SESSION 
To load data, go to the Backstage and select [Load Data]. Navigate to where your data is located and 

select the data that you wish to load into the session.  

As the data is ingested, it will be added to the data items in the Session section of the Backstage.  Raster 

data without pyramids (reduced resolutions, R-sets, etc.) will have the pyramids automatically 

generated for optimal viewing quality.  Until the pyramids have been generated, you will have minimal 

functionality for those images. Raster images with no pyramids generated will have a warning icon 

overlaid on the image icon in the Session data section. 

Note: Large datasets may take some time to load, especially large vector sets.  Be patient, as these will 

appear in the Session shortly. 

2.2 VIEWING RASTER DATA 
Once the data has been loaded into the current session, it can be sent to the viewers for visualization 

and exploitation.  Raster Data, once loaded, appear in the Image Gallery as a set of thumbnails (Figure 1, 

area 4).  Other geospatial data (vectors, tie points, and annotations) appear in the Layer Manager 

(Figure 1, area 5).   

2.2.1 EXPLORING RASTER DATA 
Raster data can be loaded into the viewers by right-clicking on the thumbnail of the data in the Image 

Gallery and selecting “Send to Left Viewer” or “Send to Right Viewer”.  The image will be loaded into the 

chosen Viewer and a small arrow will appear in the bottom corner of the image thumbnail in the Image 

Gallery to indicate which Viewer the image is loaded in.   

You can pan the image by clicking and dragging with the center mouse button (the scroll wheel on many 

mice).  Free zooming can be performed by using the scroll wheel of your mouse.  Click into the desired 

Viewer to make it active, the roll the mouse wheel forward (away from you) to zoom out, and backward 

(toward you) to zoom in.  The zoom is centered on the viewer, allowing you to keep the region of 

interest centered at all times, no matter where the mouse cursor is. 

If you have no third mouse button or scroll wheel, you can pan by holding down both the left and right 

mouse buttons simultaneously and dragging.  Zooming can be performed using the fixed zoom intervals 

in the Home tab of the Ribbon.   
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The divider between the Left and Right Viewers can be moved by clicking and dragging anywhere on the 

divider. 

2.2.2 THE HOME TAB VISUALIZATION TOOLS 
The Home tab (Figure 3) contains a number of visualization tools useful for interacting with the loaded 

data.   

The Display group contains tools for determining how the imagery is displayed, including options for 

Histogram adjustment, Brightness/Contrast, and Filters for removing noise and enhancing structure.  

There are also a number of overlays for context awareness, including display of the North arrow, 

geospatial grid lines, overviews, and working regions.  For more information on these overlays, see 

Customizing the Viewer Display. 

 

Figure 3. The Home tab contains visualization tools for data exploration. 

The Camera group contains tools for manipulating the position of the camera, including the zoom tools, 

jump to location, viewer linking, and movement modes.  [Camera Lock] is used to geographically link the 

viewers so that movement (pan and zoom) in one corresponds to movement in the other. The camera 

movement mode can be selected as either [Pan Mode] (default) or [Roam Mode].  In the roaming 

mode, movement is accomplished by holding down the middle mouse button and dragging in the 

direction that you want the image to move. 

The Rotation group contains the tools to allow you to rotate the current view.  Free rotation can be 

performed by selecting [Compass] and using the slider to set the desired orientation.  There are also a 

few pre-determined rotation angles.  [Image Up] orients the image such that the columns of the image 

are aligned with the columns of the viewer.  [North Up] orients the image in the viewer so that the 

direction to North – as determined by the spatial reference system – is aligned with the columns of the 

viewer.  [Z Up] orients the image so that vertical changes in elevation (such as the vertical lines of tall 

buildings) are aligned with the columns of the viewer.  There are also quick rotate buttons to quickly 

rotate 90 degrees in either direction, or 180 degrees. 

The Source DEM allows the user to specify the DEM used for viewer-related processing, including 

Camera Lock and a number of exploitation and analysis tools.  The drop down allows the user to select 

any currently loaded DEM to use as the base DEM.  Alternatively, the No DEM Selection option uses the 

default low-resolution DEM included with the software. 
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2.2.2.1 JUMP TO LOCATION 

The [Jump to Location] button in the Camera group on the Home tab provides the mechanism for you 

to center the active viewer on a specific geospatial or pixel location.  For geospatial coordinates, the 

coordinate templates for string input are controlled by the Display Format designated in the Geolocation 

Formats settings (see Geolocation Formats).  Once valid locations have been entered, press [OK] to 

center the active viewer on the provided location. 

 

Figure 4. The Jump to Location dialog lets you center on a specific point. 

2.2.3 AUXILIARY VIEWERS 
If you need more than two images for context awareness during processing, you can launch an image 

into an auxiliary image viewer by right clicking on the image thumbnail in the Image Gallery and 

selecting “Open in New Viewer” .  A new image viewer will be launched with the selected image loaded.  

The auxiliary viewers are image viewers only.  They do not contain other data layers and cannot be used 

for processing or production with any of the IApioneer modules. 

2.3 VIEWING VECTOR, TIE POINT, AND ANNOTATION LAYERS 
Data layers are types of data that can be overlaid on top of imagery to provide additional exploitation 

capabilities.  Some IAVO modules allow the creation and editing of data layers, but they can be 

visualized even without a licensed module.  Clicking on [Layer Manager] in the Data Layers group on the 

Home tab expands the Data Layer Manager if it is not currently displayed, and hides the Data Layer 

Manager if it is already visible (Figure 5).  You can also click on the button of the divider between the 

Left Viewer and the Data Layer Manager to show/hide the Data Layer Manager.  The Data Layer 

Manager can be resized by clicking and dragging on the divider. 

Each data item in the Data Layer Manager has both a checkbox and a radio button beside it.  The 

checkboxes indicate whether or not the data item is visible in the viewers.  The radio box indicates 

which data item is currently being edited.  Any number of data layers can be visible at once, but only 

one data layer can be edited at a time.   

Note: To quickly hide all off the data layers, select [Hide All] in the Data Layers group on the Home tab. 
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Figure 5. The UI showing the Data Layer Manager. 
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3 DATA MANAGEMENT 

3.1 SESSION MANAGEMENT 
The data loaded in the application is considered a Session.  IApioneer-based modules work on one 

Session at a time. IApioneer can save the state of your workspace for later processing using the [Save 

Session] or [Save Session As] functionality in the Backstage, accessed from the File tab.  The saved 

Session (*.xpj file) contains the references for the currently loaded data items, allowing for quick 

recovery of a previous set of data. 

Archived Sessions can be retrieved by selecting [Open Session] and navigating to the desired Session 

file. 

Clicking on [Close Session] closes out the current Session, prompting you to save individual data items 

that have pending changes.  Once pending changes to individual items have been saved, you will be 

prompted to save the current Session before all items are removed and a new Session is created. 

3.2 RASTER IMAGE PROPERTIES 
To view or edit the properties of a raster image, go to the Session section on the Backstage, right click on 

the image that you wish to modify, and select “Properties”.  The Properties dialog has four tabs:  

 General – This tab contains information about the image itself, including basics such as file size, 

type, image dimensions, number of bands, and the type of image (Image or DEM).  It also has 

indicators as to whether or not the image has embedded metadata for spatial referencing 

information, affine transforms, or RPC sensor models.  Finally, it contains an estimate of the 

image GSD and its geospatial bounding box. 

 Metadata – This tab contains metadata tags embedded in image formats such as NITF. 

 Band Info – This tab provides information about the number of bands in the image, each band’s 

format, and a histogram estimate per band. 

 Sensor Model – This tab is where the user is able to view or set the sensor model information 

used for the photogrammetric calculations with each of the software processing modules.  

There are three sensor model formats supported: frame camera, RPC, and orthographic.   

Note: You can specify that  an orthographic image is a DEM from the General Properties tab.  Click on 

the Image Type button to change an orthographic image from a raster Image to a DEM. 
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4 SETTING UP CAMERA SENSOR MODELS 
Most geospatial raster data have inherent metadata, which incorporates both the spatial referencing 

system that the data was acquired in, as well as the sensor model defining the projective nature of the 

image data.  IApioneer supports three sensor model formats: frame camera (scanned film and digital 

back), RPC, and orthographic.  Any image data loaded without embedded sensor model information will 

default to a unitary orthographic sensor model. 

To set/modify the sensor model for a raster image, go to the Session section of the Backstage and right-

click on the image.  Select “Properties”, and navigate to the Sensor Model tab of the Properties dialog. 

4.1 SPATIAL REFERENCE SYSTEMS 
A Spatial Reference System (SRS) is a coordinate-based system (local or global) that is used to locate 

geospatial data points.  A SRS consists of a Projection and a Datum.   

A Projection transforms the earth’s 3D surface into a flat (2D) representation at either a local or global 

level.  There are a number of projections in current use, but most are based on a conical, cylindrical, or 

azimuthal model. 

A Datum is a mathematical construct approximating the earth’s surface, allowing measurements to be 

made along the surface.  The most commonly used Datums are ellipsoidal, or geoidal in nature.  The 

ellipsoidal model approximates the surface as a 3D ellipsoid, as defined by a set of mathematical 

parameters.  An example would be the WGS84 ellipsoid.  A geoidal model uses a network of physical or 

derived measurements to define the 3D surface.  An example would be the EGM96 model. 

If you look at the same point using two different projections or datums, the geospatial coordinates of 

that point will differ.  Be sure to use the correct SRS parameters for your data to ensure accurate 

processing. 

4.1.1 CONFIGURING SPATIAL REFERENCE SYSTEMS 
All sensor models contain a Spatial Reference System that defines the map projection of the data.  For 

some data (e.g., RPC sensor models), the spatial reference system is an intrinsic one, whereas it needs to 

be explicitly assigned for other data.  For all raster data sensor models, the specification of the spatial 

reference system follows the same process.  Once the Sensor Type has been specified, select [Change] 

beside the Spatial Reference System identifier to configure the data’s spatial reference system. 

Figure 6 shows the Spatial Referencing dialog.  Here you can set the Projection, Datum, Linear and 

Angular Units, and the map projection Zone (as required).  Currently, there are a limited number of 

spatial reference systems that can be manually set in the application, though we ingest thousands of 

spatial reference systems through Well Known Text (WKT) strings. 
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Figure 6. The Spatial Referencing configuration dialog. 

Currently, the software supports the following manually selectable projections:  Latitude/Longitude, 

UTM, and State Plane.  Specifying either the UTM or State Plane projections also requires you to specify 

the appropriate Zone.  The geospatial Datums supported by the application are: WGS84, WGS72, 

NAD83, and NAD27.  The Linear and Angular unit options determine how the sensor model parameters 

are interpreted. To specify a custom spatial reference system, choose that option from the Projection 

drop-down, then copy a valid PROJCS WKT string into the text box at the bottom of the dialog. 

4.2 FRAME CAMERA SENSOR MODEL CONFIGURATION 
The Frame Camera sensor model consists of two primary sets of parameters, defining the interior 

orientation (IO) and exterior orientation (EO) parameters of the sensor as the image was acquired 

(Figure 7).  For the internal parameters, the user must have knowledge of the camera’s focal length and 

focal offset, and the internal affine representation of the sensor. If using a scanned film image, you will 

need to also have the sensor’s fiducial locations.  These are typically found in a camera calibration 

report.  Digital back images do not have fiducials, and their affine parameters are easily computed from 

the image dimensions and knowledge of either the sensor size, or the pixel size on the sensor.  In 

addition, radial distortion parameters can be provided. Exterior orientation parameters define the 

camera’s position and orientation at the time of acquisition, and are often provided in a text file 

containing the EO parameters of all the images acquired during a single flight/project.  Each of the 

parameters for the Frame Camera sensor model can be manually entered by the user. 
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Figure 7. Frame camera sensor model configuration. 

Once both the IO and EO parameters of the sensor have been set, press [OK] to apply the new sensor 

model.  In the Backstage, an asterisk will appear beside the dataset’s name, indicating that the metadata 

has changed.  The metadata must be saved for the changes to persist after the session has been closed 

out or the data has been removed from the current session. 

4.2.1 SCANNED FILM AFFINE PARAMETERS FROM FIDUCIALS 
Much of the imagery taken prior to 2005 was acquired on film and then digitized by means of a scanner.  

The affine parameters are therefore irregular.  The affine parameters can be computed from the sensor 

fiducial parameters and their measured locations on the image.  Selecting [Use Fiducials] launches the 

Fiducial Selection workflow.  This workflow walks you through the process of setting up the fiducial 

detection for the image.   

The first stage of the Fiducial Selection workflow (Figure 8) is where you set the sensor coordinates of 

the fiducials, and the orientation of the film on the scanner.  The sensor fiducial locations are typically 

found in a camera calibration report, such as that seen in Figure 9.  Select the radio button for the 

number of fiducials you were given in your calibration information, and enter the coordinates.  If you 

have a camera file (*.CAM) containing the fiducial information, you can load those values from that file. 

Note: The 4 Fiducials configuration option works for either “corners” or “cross” configurations – fiducials 

lying on the corners or the sides of the sensor, respectively. 
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Use the rotation arrows to change the orientation of the displayed image so that it appears “image up” 

in the display.  While doing so, you can use the scroll wheel to zoom in and out, and the left mouse 

button to pan around to help you set the orientation.  Once the fiducial coordinates and the scanner 

orientation has been set, click [Next] to proceed to the second stage.   

 

Figure 8. The first stage of the Fiducial Selection workflow, where you set the sensor’s fiducial coordinates. 
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Figure 9. Scanned in portion of a camera calibration report showing the principal point and fiducial locations. 

 

In between the first and second stages of the workflow, an auto-detection process is run to identify the 

locations of the fiducials in the image.  The second stage (Figure 10) shows you the result of the auto-

detection process on all the fiducials specified in the first stage.  If there are fiducials that were not 

correctly aligned with the image locations, you can manually edit their positions. 

Click on the thumbnail corresponding to the fiducial you wish to edit.  The sub-image will expand to give 

you a large canvas on which to locate the fiducial.  Click and drag the image to align with the fiducial 

mark.  You can zoom in and out to better find the precise location of the center of the fiducial marker on 

the image.  Click [Done] to finalize the position.  Repeat the process for any fiducials that need 

refinement. 

If you get too far off track, or wish to start over, click [Auto Detect] to re-run the auto-detection 

process.  Once the fiducial marks have been aligned, press [Finish] to compute and assign the affine 

parameters. 
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Figure 10. The second stage of the Fiducial Selection workflow, where you can confirm the fiducial alignment. 

 

4.2.2 DIGITAL AFFINE FROM SENSOR INFORMATION 
Images taken with a digital back (modern imagery) have no fiducials.  Instead, the affine is regular and 

can be computed directly from the sensor information; knowing either the sensor size or the size of a 

pixel is sufficient.   

Click [Digital Frame] to launch the Digital Frame Affine Calculation dialog.  Select the radio button for 

the parameter that you know, either Pixel Dimensions or Sensor Dimensions.  Enter the Width and 

Height for those parameters and select [OK] to set the digital affine. 
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Figure 11. The Digital Frame Affine Calculation dialog with pixels of size 12μm x 12μm. 

 

4.2.3 BATCH FRAME CAMERA SETUP 
 Aerial imagery is often acquired in large batches, either from a set of flight lines or from some other 

pre-specified flight path.  Manually editing each of the sensor models for these images would be quite a 

chore.  You can configure the sensor models for an entire batch of aerial imagery using the [Batch Aerial 

Workflow] option from the Backstage. 

The Batch Aerial Workflow will walk you through each of the steps for configuring the sensors models 

for a handful of images up to thousands at one time.  You simply follow the steps to set the fields for 

your cameras: internal parameters, external parameters, and data pairing parameters.  

The first stage of the Batch Aerial Workflow involves providing the IO parameters of the cameras.  This 

includes the focal lengths, focal offsets, distortion parameters, and internal affine information.  This 

information is provided with the camera calibration reports received with your data.  Make sure to 

choose the appropriate Sensor Affine model.  If you have images with fiducials, choose the Standard 

option.  For fully digital cameras, choose the Digital option. Figure 12 shows the first stage with the 

parameters for our test data entered.  Once the IO information is correct, press [Next] to continue. 
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Figure 12. First stage of the Batch Aerial Workflow, where you provide IO parameters. 

The second stage of the Batch Aerial Workflow is where you specify the exterior orientation parameters.  

These include the spatial reference system, the text file and containing the EO parameters, and the 

format of the text file. Figure 13 shows the second stage, with appropriate values for our test data.  

Once the information is correct, press [Next] to continue. 
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Figure 13. Second stage of the Batch Aerial Workflow, where you provide the EO parameters. 

It may happen that the Image IDs in the EO text file do not match exactly with the image names that you 

have loaded in your project.  Stage three of the Batch Aerial Workflow allows you to match the ID 

parameters in your EO text file with the appropriate images loaded into your project.  If the Image IDs 

do not match with the image files, simply select the drop down box next to each Image ID and choose 

the image it corresponds to.  Click [Next] to finish the workflow process and the software will 

automatically generate the sensor models for every image in your project. 

Once the process is complete, you should save the project.  This will save the metadata for the sensors 

you have just configured. 
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Figure 14. Third stage of the Batch Aerial Workflow, where you match loaded images with their Image IDs. 

4.3 RPC SENSOR MODEL CONFIGURATION 
Satellite imagery is typically delivered with its rigorous camera model information hidden behind a 

generic replacement sensor model in the form of RPCs.  RPC data are usually either embedded in the 

image file itself as metadata, or supplied via a secondary metadata file.  This information can be read 

from the external file, either by loading an IKONOS metadata file, or a standard RPC00B file (as seen in 

Figure 15). 

 

Figure 15. RPC sensor model configuration. 
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Once the RPC parameters have been set, press [OK] to apply the new sensor model.  In the Backstage, 

an asterisk will appear beside the dataset’s name, indicating that the metadata has changed.  The 

metadata must be saved for the changes to persist after the session has been closed out or the data has 

been removed from the current session. 

4.4 ORTHOGRAPHIC SENSOR MODEL CONFIGURATION 
Orthographic images (orthos) have been processed to remove perspective from the raster data so that 

each pixel falls on a point of a georeferenced grid.  An orthographic sensor model is defined by the 

geographic coordinates of its Upper Left Corner and the Post Spacing in both the X (horizontal) and Y 

(vertical) directions (Figure 16).  For most ortho images, the data has been processed so that traversing 

along a row of pixels corresponds to stepping along the X direction in the spatial reference system only, 

and traversing along the columns corresponds to stepping along the Y direction of the spatial reference 

system only.  However, it is possible that movement along either row or column can correspond to 

stepping both in the X and Y directions, geospatially.  This is referred to as a non-aligned ortho image. 

 

Figure 16. Orthographic sensor model configuration. 

Once the ortho parameters have been set, press [OK] to apply the new sensor model.  In the Backstage, 

an asterisk will appear beside the dataset’s name, indicating that the metadata has changed.  The 

metadata must be saved for the changes to persist after the session has been closed out or the data has 

been removed from the current session. 
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5 CUSTOMIZING THE VIEW 

5.1 CUSTOMIZING THE VIEWER DISPLAY 
The Display group in the Home tab contains a number of tools useful for adjusting how the selected 

image is displayed, as well as contextual overlays that can provide a better overview for exploitation. 

5.1.1 HISTOGRAM ADJUSTMENT 
Selecting [Histogram] launches the Color Curves dialog (Figure 17).  In this dialog, you can affect a color 

transform on individual channels, or all channels simultaneously, of the image in the active viewer.  

Output values from the color transform are scaled between 0 (black) and 1 (white).  A number of Presets 

are available for quick color transformations, including: 

 Piecewise Custom – Allows you to manually set the Input and Output values for the curve.  These 

can be set by manually clicking on a curve endpoint and dragging it to the desired position, or by 

manually entering the values in the text boxes below the curves. 

 Linear Min/Max – Sets the minimum image value to an output value of 0, and the maximum 

image value to a value of 1. 

 Linear 2% - Uses the histogram to scale the output between the 2nd percentile and 98th 

percentile of the image values. 

 Equalization – Transforms the input image histogram into a uniform distribution. 

 Gaussian – Transforms the input image histogram into a normal distribution. 

 

Figure 17. Color Curves dialog showing a Gaussian transformation. 
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As you are making changes to the color curves, the image in the active viewer will adjust according to 

your changes.  Selecting [OK] will fix those adjustments in place, while [Cancel] will revert to the last 

saved color curves. 

5.1.2 BRIGHTNESS, CONTRAST, AND FILTERS 
Use the [Brightness] and [Contrast] options to adjust the overall brightness and contrast of the image in 

the active viewer.  Clicking on one of the above options will open a gallery of preset choices, as well as a 

manual slider option at the bottom of the list. As changes are made, the active image will adjust 

accordingly to provide a preview of the changes. 

Use [Filter] to choose sharpening, smoothing, and haze reduction filters.  These filters are applied to the 

displayed data only, and can be used to quickly enhance the active image.  There are five options for 

quick filters: 

 Low Pass – This smoothing filter performs a low pass convolution on the data in the active 

image.  It uses a 5x5 smoothing kernel with normalized weights. 

 Gaussian Low Pass - This smoothing filter performs a low pass convolution on the data in the 

active image.  It uses a 5x5 smoothing kernel with Gaussian weights.  It provides less smoothing 

distortion than the Low Pass filter. 

 High Pass – This sharpening filter performs a high pass convolution on the data in the active 

image.  It uses a 5x5 convolution kernel with normalized weights. 

 Gaussian High Pass – This sharpening filter performs a high pass convolution on the data in the 

active image.  It uses a 5x5 convolution kernel with Gaussian weights. It provides less sharpening 

distortion than the Low Pass filter. 

 Haze Reduction – This combination of smoothing and sharpening filters provides local contrast 

enhancement and the removal of aerosol-like distortions in the image. 

5.1.3 IMAGE OVERVIEW 
[Image Overview] launches a small dialog with a thumbnail of the active image and a vector graphic that 

shows the current displayed bounds of the active image. 

5.1.4 NORTH ARROW AND GRID LINES 
The [North Arrow] option turns on/off a graphic depicting the direction to North in the current viewer.   

Use [Grid Lines] to turn on/off a map-coordinate grid overlay on the active image.  The map grid display 

parameters can be set in the Settings (see  
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Grid Lines).  

5.1.5 CURSOR INFORMATION 
[Cursor Information] in the Image group on the Home tab launches a dialog (Figure 18) showing the 

image (pixel) coordinates of the cursor, in addition to its projected map coordinates.  The projection 

coordinates are relayed based on the projection and display string formats specified in the Geolocation 

Formats settings.   Images that are chipped from larger sources have two sets of cursor location info; 

one for the chipped cursor location, and one for where that pixel would lie in the full image. 

 

Figure 18. Cursor Information dialog showing both full and chipped image pixel locations. 

5.2 USER SETTINGS 
To change the default settings for a variety of display and measurement operations within the UI, click 

on [Settings] in the Backstage.  The Settings dialog (Figure 19) allows you to specify how the UI displays 

certain types of information, including: measurement units, cursor information, display colors, fonts, 

and other graphics.   
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Figure 19. The Settings dialog. 

To change a setting, click on the setting type on the left tree and edit the parameters in the right hand 

side of the dialog.  Changes made to the preferences are saved on a per-user basis, allowing all users of 

a system to configure the look and feel of the software as they see fit. 

5.2.1 GEOLOCATION FORMATS 
The Geolocation Formats settings control how map information is displayed and entered (Figure 20).   

The Display Format controls how map coordinates are relayed to you in areas such as the Cursor 

Information dialog. The Display Format settings consist of a map projection, a string format, the vertical 

datum used for reporting elevation, and the units to measure elevation. 

 Projection Type – Specifies the map projection used.  Can be Native, Geographic, or UTM. 

o Native – The underlying projection of the source data 

o Geographic – Latitude/Longitude 

o UTM – UTM zone is defined by projection from the center of the source data’s bounds 

 Geographic String Format – Specifies the display string format as a decimal combination of 

degrees (DD), minutes (MM), and seconds(SS).  Only used if the Projection Type is Geographic. 

 Vertical Datum – Specifies the datum used to display elevation values.  Can be Ellipsoid(WGS84) 

or MSL (EGM96).  Value supersedes the datum used in the data’s SRS (for display purposes 

only). 

o Ellipsoid (WGS84) – Uses the WGS84 ellipsoid for reporting elevation values. 
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o MSL (EGM96) – Uses the EGM96 geoid for reporting elevation values. 

 Vertical Units – Specifies the linear units used to report elevation values. 

 

Input Format provides the template for user-derived information, such as that provided in the Jump to 

Location dialog.  The input format consists of a map projection and string format. 

 Projection Type – Specifies the map projection used.  Can be Native, Geographic, or UTM. 

o Native – The underlying projection of the source data 

o Geographic – Latitude/Longitude 

o UTM – UTM zone is defined by projection from the center of the source data’s bounds 

 Geographic String Format – Specifies the display string format as a decimal combination of 

degrees (DD), minutes (MM), and seconds(SS).  Only used if the Projection Type is Geographic. 

 

Figure 20.  Changing the geolocation format settings. 
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5.2.2 MEASUREMENT 
The Measurement  settings control how all measurements are displayed to you throughout the 

application (Figure 21).  The measurement units can be specified for Length, Area, and Angles. 

 

Figure 21. Changing the Measurement settings. 
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5.2.3 TERRAIN 
The Terrain settings is where you can configure the application to look for DTED files to use as DEM 

sources (Figure 22).  You can specify locations for DTED0, DTED1, or DTED2 DEM files.  Use the up and 

down arrows to set the priority for the elevation files. 

 

Figure 22. Changing the Terrain settings. 
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5.2.4 PIXEL CURSOR 
Use the Pixel Cursor properties to specify the look of the measurement cursor (Figure 23).  The cursor 

has an Inner Color and an Outer Color, as well as a Size – Small, Medium, or Large. 

Note: For best visibility of the cursor, set the Inner Color and Outer Color to be highly contrasting. 

 

Figure 23. Changing the Pixel Cursor settings. 
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5.2.5 DISPLAY 
Use the Display settings to configure default parameters for the viewers (Figure 24).  Currently, the only 

configurable parameter is the Image Orientation, which can be set to one of the primary rotation angles 

in the Home tab. 

 Image Up orients the image such that the columns of the image are aligned with the columns of 

the viewer.   

 North Up orients the image in the viewer so that the direction to North – as determined by the 

spatial reference system – is aligned with the columns of the viewer.   

 Z Up orients the image so that vertical changes in elevation (such as the vertical lines of tall 

buildings) are aligned with the columns of the viewer.   

 

Figure 24. Changing the Display settings. 
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5.2.6 GRID LINES 
The appearance of the geospatial grid overlay found on the Home tab can be configured through the 

Gridlines settings (Figure 25). Currently, the only allowed map Projection is Geographic (lat/long).  The 

Line Color and Line Style can be configured, as well as the Line Weight and other drawing parameters for 

the Major and Minor Axis. 

 

Figure 25. Changing the Gridlines settings. 
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5.2.7 ROI 
The ROI settings can be used to change the default appearance of the region of interest, as accessed 

through the Home tab (Figure 26).  You can specify the Line Color, Line Weight, and Line Style here. 

 

 

Figure 26. Changing the ROI settings. 
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6 EXPORTING YOUR DATA 
IApioneer is capable of exporting a number of data types for easy ingestion into other utilities.  Both 

raster data and vector data can be exported,  for a variety of product delivery types. 

6.1 CROP, RESAMPLE, AND REPROJECT RASTER DATA 
The primary mechanism for exporting raster data is the Crop, Resample, and Reproject dialog (Figure 

27).  This dialog is accessed from the  Backstage by right-clicking on the raster image that you wish to 

export and selecting the “Crop, Resample, and Reproject” option. 

The Crop, Resample, and Reproject dialog allows the user to chip a sub-image from the original raster 

data.  The bounds of the chipping process can be set to pixel values, either by click-dragging a 

highlighted rectangle in the image thumbnail, or by specifying the pixel locations in the dialog itself.  

Alternatively, the user can crop the image based on geospatial coordinates by selecting [Use Geospatial 

Coordinates].  From that dialog (Figure 28), the user can specify the Spatial Reference System used as 

the base map projection, and the bounding coordinates of the sub-image.   

A third option is to define the sub-image boundaries from another geospatial data item, by clicking 

[From Other Data].  The Geospatial Data Selection dialog allows the user to select another data item as 

the basis for the chip boundaries, as well as a buffer around that data, if desired. 

Checking the Resample box allows you to specify the nominal GSD (spatial resolution) of the output 

image.  Here you can specify the Resolution and Linear Units. 

You can change the output spatial reference system for Orthographic sensor models only by selecting 

the Reproject checkbox and setting the output spatial reference system.  This changes the base map 

projection for the output sub-image 

Once the chipping parameters have been specified, selecting the Filename and output format for the 

sub-image is the final step.  Pressing [OK] kicks off the chipping process.  When complete, the generated 

sub-image will be added to the current session. 
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Figure 27. The Crop, Resample, and Reproject dialog allows you to export sub-images. 

 

 

Figure 28. Select chip boundaries from geospatial 
coordinates. 

 

Figure 29. Select chip boundaries from another data item. 

 

  



 

IApioneer User’s Guide v3.0 – May 2014 Page 38 

 

6.2 RASTER DATA TYPE CONVERSION 
Raster data can be converted from one data type (float, int, etc.) to another.  This is accomplished by 

right-clicking on the raster data item in the Session section of the Backstage and choosing “Data 

Conversion”.  Data conversion  allows you to convert raster data from one Data Type (Byte, Short, 

Unsigned Short, Int, Unsigned Int, Float, Double) to another, as seen in Figure 30. This is a batch process, 

meaning that multiple images can be processed at a time by selecting them in the Backstage and 

launching the dialog on the group.  The user selects the output Data Type and File Format from the 

dropdown boxes, the output filename – or output directory plus suffix for multiple images – and kicks 

off the conversion process by selecting [Run].  Once the process is complete, the generated items will be 

added to the current session. 

 

Figure 30. The Data Conversion dialog allows the user to convert from one data type to another. 

6.3 EXPORT RASTER DATA 
Rich-clicking on a single (or multiple) raster item(s) in the Backstage and selecting the “Export” option 

will launch the Export Images dialog (Figure 31).  Here, you can export the selected images as they are, 

changing only the File Format, as desired.  This is another batch operation dialog, where multiple images 

can be processed at a time by selecting them in the Backstage and launching the dialog on the group.  

The user selects the output File Format from the dropdown boxes, the Output Filename – or Output 

Path plus Suffix for multiple images – and kicks off the conversion process by selecting [Run].  Exporting 

imagery is typically only used to convert file formats for use in other applications, but the user can 

choose to add the generated items to the current session by selecting the Add Results to Project 

checkbox. 
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Figure 31. The Export Images dialog provides the ability to export an image in a different file format. 

6.4 REGION OF INTEREST AND IMAGE CHIPPING FROM VIEWERS 
Often, you want to indicate a working area, or deliver a portion of the image identified in the active 

viewer.  This can be an actual image chip, or simply a JPEG graphic to use for a briefing.  IApioneer 

provides several mechanisms for identifying ROIs and using them in production scenarios. 

6.4.1 REGION OF INTEREST 
You can specify a ROI from the Home tab by clicking the [Region of Interest] gallery and choosing “Set 

Region of Interest”.  This allows you to rubber band select (click and drag) a ROI in the active viewer.  

The ROI can be hidden (or shown again, once hidden) by clicking on the [Region of Interest] button 

itself.  The appearance of the ROI is controlled via the ROI settings (see Customizing the View, Settings,   
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ROI).  

The ROI can be used in product delivery to designate a working region, or for image chipping. 

6.4.2 IMAGE CHIPPING 
The Image Chip functionality in the Image group of the Home tab provides a shortcut to the Crop, 

Resample, and Reproject dialog (see Crop, Resample, and Reproject Raster Data), with the crop 

boundaries pre-set to either the current view, or to the current ROI. 

You can chip the image in the active Viewer to the bounds of the current ROI by clicking on the [Image 

Chip] gallery, and selecting “Chip from ROI”.  The Crop, Resample, and Reproject dialog will be launched, 

with the bounding image coordinate pre-set to align with the current ROI. 

Likewise, selecting “Full Screen Chip” from the [Image Chip] gallery launches the Crop, Resample, and 

Reproject  dialog with the bounding image coordinates pre-set to align with the current viewing bounds 

of the active Viewer. 

6.4.3 SCREEN CAPTURE 
You can save the active Viewer (and its contents) to a flat format image file (e.g., JPEG) by selecting the 

[Screen Capture] option in the Image group of the Home tab.  The screen capture mechanism stores all 

of the visible information in the active Viewer in a variety of standard flat format image types (*.bmp, 

*.jpg, *.png, *.tif) for ingestion into other products, such as a PowerPoint briefing. 

6.5 EXPORTING VECTOR DATA 
Vector data can be exported in a variety of formats for archival and ingestion into other data processing 

packages.  Go to the Backstage and right-click on the vector data item you wish to export.  Choose the 

“Export” option to launch the vector Export dialog. 

The Export dialog allows the user to export the selected vector file, with options for output format, 

projection, texturing, and more (Figure 32).  The Output Format parameter includes the most common 

geospatial 2D and 3D file formats, including: 

 GeoVector (IAVO proprietary) 

 ESRI Shapefile 

 Presagis OpenFlight 

 Collada 

 KML/KMZ 

 Wavefront OBJ 

 PLY 

 XYZ point set 

 Common Data Base (CDB) 
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The Reproject Data checkbox is used to convert the vector file’s spatial reference system from the 

original to one of your choosing.  Click [Change] to specify the output spatial reference system. 

Output formats that include texture information can have automatic texturing  applied to the data by 

checking the Include Textures checkbox.  With that option checked, click [Change] to specify which 

images will be used to automatically texture the data.  The automatic texturing process takes into 

account camera look angle, spatial resolution, and occlusions to identify the best texture patches for 

every polygon in the dataset.   

Complete the operation by selecting the Output Filename and pressing [Export]. 

 

Figure 32. The Vector Export dialog allows the user to export 2D and 3D vector data in a variety of formats. 
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7 IAPIONEER ANALYSIS 
7.1 What is IApioneer Analysis? 

IApioneer  Analysis is a module of the IApioneer family of geospatial processing applications. It is used 

for imagery exploration, exploitation, analysis, and annotation.  Specifically, the Analysis module is 

focused on product annotation and delivery, allowing the user to generate annotated products that can 

be delivered in the form of PowerPoint briefings, chipped datasets, and other single-layer export 

process.  These annotation overlays can be saved and distributed as viewable layers to anyone with 

IApioneer. 

IApioneer Analysis offers the capability to: 

 Annotate imagery with text boxes, point markers, and simple geometry 

 Measure length, area, and azimuth values with a few mouse clicks 

 Capture screenshots of annotated products 

 Save annotations for future use and distribution to other IApioneer users 

 Use intuitive drawing mechanisms to develop sophisticated products 

7.2 Annotation Layer Management 

Annotation Layers are individual documents within IApioneer, and are listed in the Session section of the 

Backstage, under the Annotations heading.  From the Backstage, Annotation Layers can be created, 

saved, and loaded. 

When working with Annotation Layer data, use the Data Layer Manager to specify the active Annotation 

Layer for editing and viewing. 

7.2.1 Creating an Annotation Layer 

Click [Add Annotation Layer]  in the Session section of the Backstage to create a new annotation layer.  

The new Annotation Layer will be added to the session as an Unnamed Annotation Document, ready for 

editing or saving.  To change the Annotation Layer’s name, save it (see Saving Vector Layers).  The new 

filename will become the Annotation Layer’s display name. 

7.2.2 Saving Annotation Layers 

Right click on an Annotation Layer in the Backstage and choose “Save Data” or “Save Data As” to save 

the Annotation Layer for future processing. The file will be saved in a *.gad format, which is an XML-

based  IAVO internal file format. 
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 Save Data – Allows you to store the Annotation Layer.  If there is no file currently associated 

(i.e., a new Annotation Layer) you will be prompted to provide a filename.  That filename will 

become the name of the Annotation Layer. 

 Save Data As – To prevent you from overwriting the original document, the Save Data As 

command  stores the current Annotation Layer in a new document. 

7.2.3 Loading Annotation Layers into the Session 

Ingestion of Annotation Layers is the same as ingestion of raster data (or any other data type).  Use the 

[Load Data] option in the Backstage, and point the file dialog to the annotation data file(s) you wish to 

load. 

7.3 Editing an Annotation Layer 

With IApioneer, you can edit Annotation Layers, as well as create and view them.  Although annotations 

are typically drawn on a reference image, they are anchored geospatially, and thus can propagate across 

multiple images.  It is important to note that unless the data is perfectly registered, annotations drawn 

on one reference image may be slightly off (visibly) when overlaid on any other image. 

7.3.1 Annotation Visibility and Setting the Active Layer 

The first step in editing an Annotation Layer is the set it as both visible, and the active layer for editing, 

using the Layer Manager.  Figure 33 shows the IApioneer module with the Data Layer Manager visible 

and a single Annotation Layer ready for editing.  Clicking on [Layer Manager] in the Data Layers group 

on the Home tab expands the Data Layer Manager if it is not currently displayed, and hides the Data 

Layer Manager if it is already visible.  You can also click on the button of the divider between the Left 

Viewer and the Data Layer Manager to show/hide the Data Layer Manager.  The Data Layer Manager 

can be resized by clicking and dragging on the divider. 

Each Annotation Layer in the Layer Manager has a checkbox and a radio button to the right of its name.  

The checkbox indicates visibility – checked means that the layer is visible in the Viewers.  The radio 

button indicates the active (editable) layer.  Module tabs appear in the ribbon, based on the type of the 

active layer.  When the active layer is an Annotation Layer, the Analysis module tab appears in the 

Ribbon. 
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Figure 33. IApioneer Analysis module with an Annotation Layer loaded. 

7.3.2 Adding Shapes and Clipart 

The Analysis tab contains two groups of tools for annotations and measurements.  The Insert group 

allows you to insert single shapes and MIL-STD-2525B clip art.  The types of shapes supported i include 

basic shapes – points, lines, and polygons – as well as complex items such as text boxes, point markers, 

and target rings.  Initial parameters for the appearance of the annotation objects are pulled from the 

defaults settings (see IApioneer Analysis User Settings). 

Ellipse – Select “Ellipse” from the [Shapes] drop down.  Click on the image in the location of the upper 

left corner of the ellipse’s bounding box and drag the cursor to define the ellipse.  Release the left 

mouse button to finalize the shape. 

Point – Select “Point” from the [Shapes] drop down.  Click on the image in the location of the point to 

draw the shape. 

Polygon – Select “Polygon” from the [Shapes] drop down.  Click on the image in the location of the first 

point of the polygon.  Continue clicking to set the vertices of the polygon.  The last selected point will 
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always be attached to the first point, closing the polygon.  Once the last vertex has been placed, right-

click to finish drawing. 

Polyline – Select “Polyline” from the [Shapes] drop down.  Click on the image in the location of the first 

point of the polygon.  Continue clicking to set the vertices of the polygon.  Once the last vertex has been 

placed, right-click to finish drawing. 

Rectangle – Select “Rectangle” from the [Shapes] drop down.  Click on the image in the location of the 

upper left corner of the rectangle and drag the cursor to define the rectangle.  Release the left mouse 

button to finalize the shape. 

Text Box – Select “Text Box” from the [Shapes] drop down.  Click on the image in the location of the 

center point of the text box.  A text box will be placed in the image and the text highlighted for easy text 

entry. Click outside of the text box to finalize the annotation. 

Point Marker – Select “Point Marker” from the [Shapes] drop down.  Click on the image in the location 

of the point marker to draw the shape.  A small circle will be drawn, indicating the location of the point.  

In addition, a text box will be drawn attached to the point, indicating the geospatial coordinates of the 

point marker. 

Target Circles – Select “Target Circles” from the [Shapes] drop down.  Click on the image in the location 

of the point to draw the shape.  A set of target rings will be drawn around the selected point, along with 

a text box indicating the geospatial coordinates of the center of the target rings.   

North Arrow – Select “North Arrow” from the [Shapes] drop down.  Click on the image in the location of 

the point to draw the shape.  Unlike other clip art-style graphics, which maintain their orientation with 

respect to the viewer as the image is rotated – the North Arrow graphic always indicates the direction of 

True North for images with the appropriate support data. 

Clip Art – Clip art can be added as graphic annotations to the image through the use of the Clip Art 

dialog.  Click on [ClipArt] in the Insert group to launch the dialog.  (Note: Currently, IApioneer only 

supports the Warfighting symbols from the MIL-STD 2525B graphics objects.) 

To place a graphics object from the library of images, navigate the tree structure to find the desired 

graphic.  As the tree is navigated, the contents of the library folders are previewed in the graphic pane 

to the right.  When the desired graphic has been found, click on the preview icon in the right pane and 

drag the icon into the image viewer.  Release the left mouse button to drop the graphic into the viewer, 

centered at the point of release. 
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7.3.3 Adding Linear and Angular Mensuration Annotations 

The Inspect/Measure group of the IApioneer tab provides tools for linear and angular measurement. 

Initial parameters for the appearance of the annotation objects are pulled from the defaults settings 

(see IApioneer Analysis User Settings). 

Separation Angle – Click [Separation Angle] to begin measuring an angle in the image.  Begin by clicking 

on an endpoint of the angle.  Then, click the pivot vertex of the angle, and finish by clicking on the other 

angle endpoint.  As the cursor moves to the final position, the angle measurement between the first line 

segment and the one joining the pivot point to the cursor is continually displayed, allowing the user to 

view a number of angle measurements before finally selecting the last point. 

Length – Click [Length] to begin measuring a length in the image.  Begin by clicking on the starting point 

of the line segment and finish by clicking on the endpoint.  As the cursor moves to the final position, the 

length measurement is continually displayed, along with the change in elevation, allowing the user to 

view a number of length measurements before finally selecting the last point. 

7.3.4 Editing Annotations 

IApioneer provides a limited capability to edit annotations once they have been initially drawn.  Most of 

the annotation objects can be moved by clicking anywhere on the annotation and dragging it to its new 

location.  The exceptions are Point Markers and Target Circles, which only allow their text boxes to be 

moved. 

Note: Currently IApioneer does not support editing the vertices of an annotation once placed. 

It is possible to subdivide any convex polygon with four sides (convex quadrilateral), into regularly 

sampled subregions  by right-clicking on the polygon and choosing “Subdivide”.  The Subdivide Polygon 

dialog allows you to specify the number of Rows and Columns of  the subdivision, dynamically updating 

the annotation in the Viewer to  provide immediate feedback on the final appearance.  Pressing [Apply] 

deletes the original annotation and replaces it with the subdivisions, each as a separate annotation 

object.  The subdivision annotations’ properties are copied from the parent annotation. 
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Figure 34. Polygon annotation subdivision. 

7.3.4.1 Editing the Text in a Text Box 

Double click inside any text box annotation (or the text box of a complex annotation object) to edit the 

text.  Type the new text, including carriage returns, and click outside the text box to finalize the changes. 

7.3.5 Viewing and Editing Annotation Properties 

Each annotation object has a set of properties that contain appearance parameters for its geometry and 

textboxes, as well as mensuration information.  Some annotations may contain one, two, or even all 

three of these sets of parameters.  Default parameters for each of these parameters are pulled from the 

Settings, but you can change these properties for individual annotations.  These properties can be 

accessed by right-clicking on the annotation and choosing the “Properties” option. 
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7.3.5.1 Geometry Properties 

The Geometry properties tab in the Annotation Properties dialog allows you to specify the drawn 

appearance of the vector segments that make up the annotation object.  Figure 35 shows an example 

for polygon annotation.  You can specify visual parameters such as Line Color, Line Weight, Line Style, 

and Fill Color.  You can also specify whether the centroid of the object should be shown, as well as the 

endpoint direction. 

 

Figure 35. The Geometry properties of a polygon annotation. 
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7.3.5.2 Textbox Properties 

The Textbox properties tab in the Annotation Properties dialog allows you to specify the appearance the 

text for annotation objects that contain textboxes.  Here, you can specify the Font properties and 

Effects, as well as the Foreground and Background colors.  An example of the Textbox properties for a 

point marker annotation is shown in Figure 36. 

 

Figure 36. The Textbox properties for a point marker annotation. 
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7.3.5.3 Mensuration Properties 

The Mensuration properties tab in the Annotation Properties dialog gives you metrics about the selected 

annotation.  These include Area, Perimeter, and Centroid information.  The units used for reporting here 

are drawn from the Measurement default settings.  Figure 37 shows an example of the mensuration 

properties for a polygon annotation. 

 

Figure 37. The Mensuration properties of a polygon annotation. 

7.4 IApioneer Analysis User Settings 

To change the default settings for the annotation objects in IApioneer, click on [Settings] in the 

Backstage.  The IApioneer group in the Settings dialog is where the defaults for each of the annotation 

objects reside. 

To change a setting, click on the setting type on the left tree and edit the parameters in the right hand 

side of the dialog.  Changes made to the preferences are saved on a per-user basis, allowing all users of 

a system to configure the look and feel of the software as they see fit. 

7.4.1 Footprints 
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The Footprints settings control how DPPDB footprints are displayed in the viewer (Figure 38).  You can 

specify the Line Color, Line Style, and Line Weight for both the Controlled Footprint and the Uncontrolled 

Footprint of a DPPDB segment.  

 

Figure 38. Changing the Footprints settings. 
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7.4.2 Mensuration Tools 

The Mensuration Tools settings control how mensuration annotations appear (Figure 39).  You can 

specify the default look and feel of the mensuration tools by specifying the Font parameters and Effects, 

as well as the Foreground and Background colors for the text.  You can also specify the Line Properties of 

the mensuration vector components. 

 

Figure 39. Changing the Mensuration Tools settings. 
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7.4.3 Point 

The Point settings control how point annotations appear (Figure 40).  You can specify the default Color, 

Weight, and Style for the Point annotation. 

 

 

Figure 40. Changing the Point annotation settings. 
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7.4.4 Point Marker 

The Point Marker settings control how the point vector appears (Figure 41) for the point marker 

annotation.  The textbox portion of the annotation object is controlled via the  
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Textbox settings.   

 

 

Figure 41. Changing the Point Marker annotation settings. 
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7.4.5 Polygon 

The Polygon settings control how polygon annotations appear (Figure 39).  You can specify the default 

look and feel of the polygon annotations by specifying the Line Properties of the vector components.  

You can also specify whether the Show Endpoint Direction and Show Centroid parameters are initially 

checked.  The Fill Color can also be specified here. 

 

 

Figure 42. Changing the Polygon annotation settings. 
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7.4.6 Polyline 

The Polyline settings control how polygon annotations appear (Figure 43).  You can specify the default 

look and feel of the polygon annotations by specifying the Line Properties of the vector components.  

You can also specify whether Show Endpoint Direction is initially checked.   

 

 

Figure 43. Changing the Polyline annotation settings. 
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7.4.7 Target 

The Target settings control how target circle annotations are initially constructed (Figure 44Figure 39).  

You can specify the Marker Color for the annotation object delineating the center of the target 

annotation.  Here, you can also specify parameters for the default rings, including the Damage Ring 

Units, and the initial Radius and Colors for the ring annotations. The textbox portion of the annotation 

object is controlled via the   
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Textbox settings.   

 

 

Figure 44. Changing the Target annotation settings. 
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7.4.8 Textbox 

The Textbox settings (Figure 45) control the Font, Effects, and Color parameters for both standalone 

textbox annotations, as well as textboxes that appear as a component in complex annotations (e.g., 

point markers,  target rings).  The Line Properties are used for both the textbox border, as well as any 

necessary callout lines for complex annotations. 

 

 

Figure 45. Changing the Textbox annotation settings. 



 

IApioneer User’s Guide v3.0 – May 2014 Page 61 

 

8 FEATUREXTRACT 

8.1 WHAT IS FEATUREXTRACT? 
FeatureXTract is a module of the IApioneer family of geospatial processing tools.  It is used for 2D and 

3D modeling and feature extraction, with simplified tools for identifying features in overlapping 2D 

images and modeling them in 3D space.  All you need is two or more overlapping images, with support 

data, to easily extract points, edges, and polygons to create accurate 3D scenes of roads, buildings, and 

more. 

FeatureXTract offers the capability to: 

• Perform geospatially accurate 3D modeling from overlapping satellite and aerial imagery  

• Streamline the feature extraction process through draw and match technology 

• Rapidly extract 3D buildings and roads 

• Export feature layers for use in GIS applications 

• Export textured features to Presagis, Google Earth for use in visual simulation applications or 

editing 

• Automatically texture map the extracted scenes 

8.2 VECTOR LAYER MANAGEMENT 
Vector Layers are individual documents within FeatureXTract, and are listed in the Session section of the 

Backstage, under the Vectors heading.  From the Backstage, Vector Layers can be created, saved, and 

loaded. 

When working with Vector Layer data, use the Data Layer Manager to specify the active Vector Layer for 

editing and viewing. 

8.2.1 CREATING A VECTOR LAYER 
Click [Add Vector Layer]  in the Session section of the Backstage to create a new vector layer.  The new 

Vector Layer will be added to the session as an Unnamed Feature Set document, ready for editing or 

saving.  To change the Vector Layer’s name, save it (see Saving Vector Layers).  The new filename will 

become the Vector Layer’s display name.  

8.2.2 SAVING VECTOR LAYERS 
Right click on a Vector Layer in the Backstage and choose “Save Data” or “Save Data As” to save the 

Vector Layer for future processing. The file will be saved in a *.gvf format, which is a binary IAVO 

internal file format. 
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 Save Data – Allows you to store the Vector Layer.  If there is no file currently associated (i.e., a 

new Vector Layer) you will be prompted to provide a filename.  That filename will become the 

name of the Vector Layer. 

 Save Data As – To prevent you from overwriting the original document, the Save Data As 

command  stores the current Vector Layer in a new document. 

 Export – Allows you to save the data in a number of different file formats.  

8.2.2.1 VECTOR DATA EXPORT 

Choosing “Export” launches the Export dialog (Figure 46), where you can specify the Output Format.  

Depending on the format chosen, you may be able to Reproject Data, Include Textures, or Center the 

Data at the Origin. 

 

Figure 46. The vector data Export dialog allows you to save your vector data in a number of common output formats. 

Reproject Data allows you to transform the vertices of the selected vector dataset from one spatial 

reference system to another. 

For output formats that support texturing, checking the Include Textures checkbox allows you to specify 

the textures used for automatic texturing of the data.  Click [Change] beside the Include Textures listing 

to specify the textures used for the automated texturing process.  In the GeoData Selection dialog, select 

the images to use for texturing and hit [OK].  When the export process is run, each polygon in the vector 

data set will be textured with the “best” texture segment pulled from the selected images, based on a 

number of criteria including: best camera angle, highest resolution, and minimal occlusions. 

Choose the Center Data at Origin option for those file formats that are designed to be used with data 

centered about the origin (0,0,0). 

Once your options have been set, provide an Output Filename, and click [Export] to run the export 

process.  This process can be lengthy for large datasets with textures. 
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8.2.3 LOADING VECTOR LAYERS INTO THE SESSION 
Ingestion of Vector Layers is the same as ingestion of raster data (or any other data type).  Use the [Load 

Data] option in the Backstage, and point the file dialog to the vector data file(s) you wish to load. 

8.3 EDITING A VECTOR LAYER 
With FeatureXTract, you can edit Vector Layers, as well as create and view them. It is important to note 

that unless the data is well registered, features extracted between one pair of images may not align 

exactly with another pair.  

Whether you are extracting planar features from orthographic images, or 3D features from overlapping 

imagery, FeatureXTract depends on the underlying elevation source.  There are three primary elevations 

sources that FeatureXTract draws from.  In order (least priority to highest) they are: the low resolution 

DEM provided with the FeatureXTract install, user-provided DTED, and a user-specified DEM.  The best 

choice, if you have it available, is to load a high resolution DEM into the application, and specify it as the 

working Source DEM in the Home tab of the Ribbon.  Alternatively, in the Settings section of the 

Backstage, you can specify a directory location for local or network DTED data.  Finally, if no other 

source of elevation can be found, FeatureXTract is deployed with a low resolution elevation model of 

the earth. 

The command actions Copy (CRTL-C), Paste (CTRL-V), and Undo (CTRL-Z) are available during the vector 

editing process. 

8.3.1 VECTOR LAYER VISIBILITY AND SETTING THE ACTIVE LAYER 
The first step in editing a Vector Layer is to set it as both visible and as the active layer for editing, using 

the Layer Manager.  Figure 47 shows the FeatureXTract module with the Data Layer Manager visible and 

a single Vector Layer ready for editing.  Clicking on [Layer Manager] in the Data Layers group on the 

Home tab expands the Data Layer Manager if it is not currently displayed, and hides the Data Layer 

Manager if it is already visible.  You can also click on the button of the divider between the Left Viewer 

and the Data Layer Manager to show/hide the Data Layer Manager.  The Data Layer Manager can be 

resized by clicking and dragging on the divider. 

Each Vector Layer in the Layer Manager has a checkbox and a radio button to the right of its name.  The 

checkbox indicates visibility – checked means that the layer is visible in the Viewers.  The radio button 

indicates the active (editable) layer.  Module tabs appear in the ribbon, based on the type of the active 

layer.  When the active layer is a Vector Layer, the FeatureXTract module tab appears in the Ribbon.  

You can have any number of data layers loaded and visible, but only one data layer can be edited 

(active) at a time. 
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Figure 47. FeatureXTract module with a vector layer loaded and ready for editing. 

8.3.2 CREATION TOOLS 
The FeatureXTract Creation group contains the basic geometries used to extract complex 2D and 3D 

features from the imagery.  The types of geometries supported include: polygons, points, polylines, and 

circles. The creation tools are modal, meaning that one creation mode is active at all times.  This allows 

you to quickly draw many items of the same geometry without having to return to the Ribbon. 

For all geometries, except points, the drawing process is similar.  Begin by holding the CRTL key and left-

clicking to set the initial point.  Release the CTRL key and continue to left click each vertex of the 

geometry you are modeling. When you have placed the last point, right-click to finalize the shape. 

Note: Mis-click a point?  You can use the Backspace key to remove the last vertex you placed.  Or, if you 

wish to start completely over, use the ESC key. 

Polygon – There are two types of polygons that are available from the Polygon gallery: Polygon, and 

Box.  A Box is a special form of Polygon where all the sides of the geometry are parallel or perpendicular 

to the first drawn segment.  Alternatively, you can hold down the CTRL key while drawing a standard 
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Polygon and force the newest line segment to be perpendicular to the last drawn line segment.  All 

Polygons are closed shapes, where the last vertex placed is always connected back to the first placed 

vertex. 

Point – To draw a Point, CTRL-click to place the point in the image. 

Line – The Line object can be used to draw single line segments, or joined segments as a polyline.  

Circle – A Circle is drawn by placing three points anywhere on its perimeter.  

8.3.3 MANIPULATION TOOLS 
The FeatureXTract Manipulation group contains the tools necessary to convert the drawn geometries to 

accurate 3D shapes by visibly aligning the geometries in the images. Making 3D models is simply a 

matter of drawing the shapes in one image, and then visibly aligning them in another.  The available 

manipulation actions are: epipolar, z-axis, freehand, and rotation.  Like the Creation tools, the 

Manipulation tools are modal, with one Manipulation mode active at all times. 

Move Epipolar – Clicking and dragging objects when the Epipolar movement mode is active restricts 

movement to the epipolar line defined by the relationship between the sensor models of the images in 

the Left and Right Viewers.  This is the primary manipulation mode used to model in 3D between two 

images.  By drawing the geometry in one Viewer and moving it along the epipolar line in the other 

Viewer until it aligns with the imagery, you can accurately place the geometry in 3D space. 

 Move Z-Axis – Clicking and dragging objects when the Z-Axis movement mode is active restricts 

movement to the local z-axis, as defined by the data’s spatial reference system.  

Move Freehand – Clicking and dragging objects while the Freehand movement mode is active restricts 

the movement to the local X-Y plane (keeping the z values constant), as defined by the data’s spatial 

reference system. 

Rotate – Clicking and dragging objects while the Rotate mode is active rotates the selected objects 

around the local z-axis.   

8.3.4 DETAILING TOOLS 
The FeatureXTract Detailing group contains tools to add 3D details to existing geometries.  The available 

detailing actions are: polygon extrusion, feature lofting, roof building, and reversing the selected face 

normal.  Unlike the Creation and Manipulation tools, the Detailing tools are single-use operations that 

act on a selected object or group of objects. 

Extrude Polygon(s) – Extrudes the selected polygon(s) to the specified elevation source (user-specified 

DEM, DTED, or embedded DEM). 
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Loft Feature – Loft a selected polygon to a point, or another polygon of the same topology (number of 

sides).  Use the Loft action to generate any conic form, such as: cone (circle to point), pyramid (polygon 

to point), truncated cone (circle to circle), or truncated pyramid (polygon to polygon).  Combine lofting 

with Rotation and Freehand movement to add twist and skew to your conics. 

Build Roof – Speed up the roof modeling process by using one of our pre-defined parameterized roof 

models.  Select a base polygon defining the gutter line of the roof, then choose from Pitched, Cylindrical 

(barracks, Quonset), or Dome.  Specify the parameters to generate the roof and the software will build 

the roof for you. 

Reverse Face – Sometimes in the creation process, your face normals may be reversed from how you 

intended to draw them.  Use this tool to reverse the directions of the selected faces. 

8.4 BUILDING A SIMPLE MODEL 
Let’s start by constructing a simple 3D model of a rectilinear building with a simple superstructure.  First, 

create a new vector layer and then make it the active layer for editing (see Creating a Vector Layer and 

Vector Layer Visibility and Setting the Active Layer).  Next, load overlapping imagery into the Left and 

Right Viewers.  Navigate to a simple rectangular building, such as that seen in Figure 48.   

On the FeatureXTract tab, select the Creation mode as Polygon.  Draw the outline of the roof (the 

gutterline) in the Left Viewer by CTRL-clicking the first point, and then clicking on each vertex of the 

gutterline.  Once the last point has been placed, right-click to finalize the shape.  In the Right Viewer, the 

shape will be projected, based on the elevation drawn from the elevation source specified – DTED or a 

Source DEM, if you specified that in the Settings or from the Source DEM on the Home tab; the default 

elevation model, if not.   

Set the Manipulation mode to Move Epipolar.  In the Right Viewer, click on the polygon and drag it along 

the epipolar line until the shape aligns with the building’s gutterline in the Right Viewer (Figure 48).  

Once the shapes are aligned in both images, the polygon has been accurately located in 3D space.   

Next, click [Extrude Polygon(s)] in the Detailing group.  The selected polygon will be extruded to the 

underlying elevation source to provide a 3D structure. 



 

IApioneer User’s Guide v3.0 – May 2014 Page 67 

 

 

Figure 48. Set the 3D location of the polygon by visually aligning it in both images. 

To add the superstructure, repeat the process above, outlining the perimeter of the superstructure.  

When the superstructure is extruded, the base of the structure is lying on the terrain.  However, we 

want the base to lie on top of the building, not on the terrain.  Set the Manipulation mode to Move Z-

Axis.  Click on the base of the extruded superstructure.  Because there are multiple overlapping polygons 

at the location where the cursor was clicked, the Select Feature dialog (Figure 49) will appear.  All the 

features lying beneath the cursor appear in the selection dialog, in order of elevation – the lowest 

elevation sources are on the bottom of the list, with features having the highest elevation on the top of 

the list.  Selecting a feature in the list highlights the feature in the Viewers. Press [OK] to select the 

feature.  Once the bottom feature has been selected, click and drag inside the feature to raise the 

elevation until it is aligned with the bottom of the superstructure in the image, as seen in Figure 50. 

Note: Multiple features can be selected by holding Shift and repeatedly launching the Select Features 

dialog. 
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Figure 49. The feature selection dialog. 

 

 

Figure 50. 3D building model with superstructure. 
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8.5 BUILDING MORE COMPLEX MODELS 
Using the same principles as Constructive Solid Geometry (CSG), where complex solids are built using 

binary operations on simpler primitives, you can build complex 3D site models in FeatureXTract using a 

combination of simple tools.  For example, a water tank could be represented by a cylindrical body and 

conical top.  We can model a water tower by combining the cylinder and cone, along with the stanchions 

and supporting elements. 

8.5.1 USING THE LOFT TOOL TO CREATE CONICS 
Cones, pyramids, and the truncated forms of these shapes can be easily created using the Loft Feature 

tool in the Detailing group of the FeatureXTract tab.  This allows us to rapidly create common geometry 

that would be difficult to create by hand.   

For example, the cone of the building in Figure 51 was created by drawing a circle on the top of the 

superstructure, followed by a point to represent the tower tip, and moving the shapes along the 

epipolar lines to set the 3D locations.  Then, drag-select the two shapes and press [Loft Feature].  

FeatureXTract will automatically connect the vertices of the base polygon (circle) to the point to form 

the cone.  This same process can be performed with any base polygon to form a polygonal pyramid. 

 

Figure 51. Loft a circle to a point to create a cone. 

 

Many roof types are in the form of truncated pyramids.  For example, see the main roof of the building 

in Figure 52.  Create the polygons representing the lower and upper roof lines, and move the shapes 
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along the epipolar lines to set their 3D locations.  Select both shapes and press [Loft Feature] to form 

the truncated pyramid roof.  

 

Figure 52. Loft a polygon to another polygon to create a truncated pyramid. 

 

8.5.2 USING THE SNAPPING TOOL FOR COMPLEX GEOMETRY 
The roof shape in Figure 52 can be also be generated using the snapping tool.  The snapping tool (SHIFT) 

allows you to connect new geometry to existing vertices, and is one of the primary mechanisms used for 

complex geometry creation.  To begin, start as in the previous example, by drawing the upper and lower 

rooflines and using the epipolar manipulation to set their 3D locations.   

Next, hold both CTRL and SHIFT and move the mouse cursor to the lower left corner of the lower (larger) 

roof polygon. The CTRL button is used to initiate the drawing process, while the SHIFT button signals the 

snapping mechanism.  When the mouse cursor is near – within 5 pixels – an existing vertex, the cursor 

will “snap” to the vertex location.  Clicking while “snapped” sets the new drawing point to the existing 

point, thereby locking the new geometry and the old geometry together.  Release the CTRL key, and 

move to the lower left corner of the upper (smaller) polygon.  When the cursor is moved more than 5 

pixels from the existing vertex, it will move freely, until moved within 5 pixels of another vertex.  Click on 

the new vertex while snapped to set the second point.  Continue around the roof section to the upper 

left corner of the upper roof polygon, and then to the upper left corner of the lower polygon.  When the 

last point has been placed, right-click to finalize the shape.  You can repeat this process for each of the 

four roof segments, as seen in Figure 53. 
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Figure 53. Using the snapping tool to build a roof structure by sections. 

Hint: Preserve your outward-facing normal by placing vertices in a counter-clockwise (right hand rule) 

order 

8.5.3 USING PARAMETERIZED ROOF SHAPES 
There are a number of parameterized roof shapes you can use as a shortcut to geometry creation.  

FeatureXTract has the capability to build pitched, cylindrical (Quonset), and dome type roofs from base 

polygons. All of these are built upon base polygons.  Pitched and barracks roofs are built upon 

quadrilaterals (ideally, rectangles), while domes are typically based on circle features (but can be built 

upon any base polygon. 

8.5.3.1 CREATING PITCHED ROOFS 

Figure 54 shows how to create a pitched roof from a rectangular roof gutterline by selecting the base 

rectangle and choosing “Pitched” from the [Build Roof] gallery in the Detailing group.  Set the Roof Axis 

to match the orientation of the pitched roof ridgeline.  Then, set the # Layers parameter to match the 

number of slopes in your roof geometry.  For a simple pitched roof, there is only one slope.  For a 

gambrel roof (such as a barn), there are two.  Once the number of layers has been set, use the Height 

parameter to adjust the height of the roof until the preview geometry aligns with the roof geometry in 

the imagery (as seen in Figure 54). Press [OK] to finalize the geometry. 

If your pitched roof has vertical ends – also known as a gabled roof – you are done.  However, if all sides 

of your pitched roof slope downward, you have a hipped roof, as is the one in Figure 54.  Creating the 

hips in FeatureXTract is straightforward.  Set the Manipulation mode to Move Freehand.  Then, in one of 

the Viewers, click on a peak vertex of your roof and drag it to align on the image, as seen in Figure 55.  

Doing this for both roof peaks sets the geometry for the hipped roof. 
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Figure 54.  Creating a pitched roof from a base polygon. 
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Figure 55. Use the Move Freehand tool to adjust the ridgeline vertices. 

8.5.3.2 CREATING CYLINDRICAL ROOFS 

Creating a cylindrical-style (barracks, Quonset) roof from a base polygon follows a similar process to that 

of the pitched roof creation (Figure 56). Select the base polygon, and then choose the “Cylindrical” 

option from the [Build Roof] gallery in the Detailing group.  Set the Roof Axis to match the orientation of 

the pitched roof ridgeline.  Then, set the # Slices parameter to match the amount of geometry 

refinement you wish to have in the final geometry.  More slices means a smoother roof, but also more 

geometry to manipulate and texture.  Once the number of slices has been set, use the Height parameter 

to adjust the height of the roof until the preview geometry aligns with the roof geometry in the imagery. 

Press [OK] to finalize the geometry. 
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Figure 56. Creating a cylindrical roof from a base polygon. 

8.5.3.3 CREATING DOMES 

You can easily create a dome from a circular feature by using the “Dome” option from the [Build Roof]  

gallery in the Detailing group.  Set the # Layers parameter to specify the geometry refinement desired.  

Then, set the Height parameter to match the preview geometry to the imagery. Press [OK] to finalize 

the geometry. 
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Figure 57. Creating a dome from a circle base. 

8.5.4 COMBINING IT ALL TOGETHER 
Combining these concepts together, it is simple to create large-scale 3D site models from overlapping 

imagery.  Figure 58 shows a compilation of hundreds of structure models covering the entire downtown 

Durham, NC area, all modeled in FeatureXTract.  You can export the final model into a number of 

formats, including textured KML (KMZ), as seen in Figure 59 (see Vector Data Export).  
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Figure 58. 3D site model containing hundreds of structures. 
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Figure 59. Exported textured KMZ site model shown in Google Earth. 
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North arrow, 10, 26 

North Up, 10, 33 

O 

ortho. See orthographic 

orthographic, 14, 24 

Sensor Model Configuration, 24 

P 

pan, 9 

Pan Mode, 10 

parameterized roof shapes, 71 

paste, 63 

pitched roof, 66 

Pixel Cursor, 32 

point, 44, 53 

settings, 53 

point marker, 45, 46, 49, 54 

settings, 54 

polygon, 44, 48, 50, 56 
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settings, 56 

subdivide, 46 

polyline, 45, 57 

settings, 57 

Projection, 14 

pyramids, 9 

R 

radial distortion, 15 

RASTER DATA, 9 

chipping, 40 

Exploring, 9 

Export, 36 

Properties, 13 

rectangle, 45 

reduced resolutions. See pyramids 

Region of Interest, 35, 39, 40 

Region Of Interest, 10 

Reproject, 36, 40 

Resample, 36, 40 

Reverse Face, 66 

Ribbon, 6 

File tab, 7 

Right Viewer, 7 

Roam Mode, 10 

roof shapes, 71 

cylindrical, 73 

dome, 74 

gabled, 71 

gambrel, 71 

hipped, 71 

parameterized, 71 

pitched, 71 

Rotate, 65 

rotation, 10 

Rotation group, 10 

RPC, 14 

Configuration, 23 

R-sets. See pyramids 

S 

Scanned Film, 16 

Screen Capture, 40 

Sensor Model, 13 

frame camera, 14 

Frame Camera Sensor Model Configuration, 15 

orthographic, 14 

Orthographic Sensor Model Configuration, 24 

RPC, 14 

RPC Sensor Model Configuration, 23 

Setting Up Camera Sensor Models, 14 

separation angle, 46 

Session, 8, 9, 13 

Session Management, 13 

Close Session, 13 

Open Session, 13 

Save Session, 13 

Save Session As, 13 

Settings. See User Settings 

shapes, 44 

snapping tool, 70 

SHIFT, 70 

Source DEM, 10, 63, 66 

Spatial Reference Systems, 14 

Configuring, 14 

Spatial Referencing dialog, 14 

SRS. See Spatial Reference System 

Subdivide Polygon, 46 

T 

Target, 58 

target circles, 45, 46 

settings, 58 

Terrain, 31 

text box, 45 

textbox, 60 

settings, 60 

Textbox 

editing, 47 

Textbox Properties, 49 

Type Conversion, 38 

U 

UI Conventions, 4 

undo, 63 

User Interface (UI), 6 

Elements of the UI, 6 

User Settings, 27, 50 

Display, 33 

Footprints, 50 

Geolocation Formats, 28 

Grid Lines, 34 

Measurement, 30 

Mensuration Tools, 52 
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Pixel Cursor, 32 

Point, 53 

Point Marker, 54 

Polygon, 56 

Polyline, 57 

Region of Interest, 35 

Target, 58 

Terrain, 31 

Textbox, 60 

V 

vector data 

export, 40 

vector layers, 61 

vectors 

circle, 65 

cones, 69 

creating, 61, 66 

creation, 64 

editing, 63 

exporting, 62 

finalize, 66 

layer management, 61 

line, 65 

loading, 63 

point, 65 

polygon, 64 

pyramids, 69 

renaiming, 61 

save, 61 

save as, 61 

selection, 67 

vector layers, 61, 63 

Viewer 

Auxilliary, 11 

divider, 10 

Send to Left Viewer, 9 

Send to Right Viewer, 9 

Visibility, 43, 63, 66 

W 

WGS84, 14, 28 

Z 

Z Up, 10, 33 

zoom, 9, 10 

 


